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License Agreement 
IMPORTANT NOTICE: Read the license agreement before using BounceBack Professional 
or BounceBack Express software. Installation of the software indicates acceptance of the 
license terms. If you do not agree with these terms return the product and all its 
components. 

License Agreement for CMS BounceBack Professional and 
BounceBack Express Software 
Grant of License and Copyrights  
A. You are granted a non-transferable license to use BounceBack or BounceBack Express, 
under the terms stated in this agreement. Title, ownership of the CMS Programs and the 
copyright in the Programs remains with CMS Products, Inc.  

B. You may not make copies, translations, or modifications of or to the above software, 
with the exception of one backup copy, your choice of medium.  

C. You may install and use one copy of the software on your computer. In addition you 
may install the software on any additional computers for the purpose of backup, restore 
or accessing data stored on your backup device only.  

D. You may not assign, sell, lease, rent, sublicenses, or transfer the BounceBack 
software. You may not reverse-engineer, disassemble, or decompile the BounceBack 
software.  

E. Upon termination of this agreement, you agree to erase all the BounceBack software 
from all mediums on which it is stored.  

F. This license terminates if you fail to comply with any of the provisions in this 
agreement.  

Limited Software Warranty  

CMS warrants that the backup software conforms to the specifications contained in the 
CMS User Guide or promotional materials for a period of thirty days from your purchase 
of the product, providing that the program is used on a computer with a compatible 
operating system. NO OTHER SOFTWARE WARRANTIES ARE EXPRESSED AND NONE 
SHALL BE IMPLIED. CMS PRODUCTS, INC., EXCLUDES ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  

Limitations of Liability  

In no event shall CMS Products, Inc., be liable to you for damages that exceed the 
amount of the license fee paid by you for the use of the program. 

U.S Government Restricted Rights

The above software is provided with restricted rights. Use, duplication, or disclosure by 
the government is subject to restrictions. 

Copyright © 2011 by CMS Products, Inc. All rights reserved. No part of this document may be reproduced in 
any form without prior written consent from CMS Products, Inc. The information and specifications in this 
document are subject to change without notice. 

CMS, CMS Products, Inc., and the CMS logo are registered trademarks of CMS Products, Inc. All other 
trademarks or registered trademarks used herein are the property of their respective owners. 

Part Number 

510180.3
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Preface 

Thank you for purchasing the CMS BounceBackTM Professional or BounceBackTM Express 
Software (automatic backup software). The software is designed so that you can easily 
install, back up, and recover your data. 

About CMS Products, Inc. 

Founded in 1983, CMS Products, Inc., has become a world-wide leader in notebook and 
desktop hard drive upgrades. 

In 1999 CMS Products introduced the first backup system developed for notebook 
computers using the PCMCIA interface and software developed by CMS. USB and FireWire 
interfaces were later added to the Automatic Backup Systems (ABS) product lines. 
Having successfully developed software and systems for notebook computers, CMS 
Products turned its attention to the desktop PC and developed Automatic Backup Systems 
based on USB and FireWire interfaces, and its own unique software providing full disaster 
recovery in the event of a hard drive failure. This software has now been extended to 
support Serial ATA interfaces. 

CMS Products’ first software only product, supporting both notebooks and desktop 
computers with internal and external backup devices, was released in Dec 2003 and 
named BounceBack Professional. 

 

Our product line includes a complete set of storage solutions: 

! BounceBack Professional – Advance featured automatic backup software 

! Automatic Backup System for Notebooks  

! Automatic Backup System for Desktops  

! Velocity Series Serial ATA backup system  

! Easy-Plug Easy-Go (EPEG) Hard Drives, replacement drives for Notebooks 

! EasyMove Transfer Kit, PCMCIA transfer kits for Notebooks designed to work with EPEG 
units 

! Fire & Forget (PCMCIA interface drive that fits in the PC card slot) 

For more information visit our web site at www.cmsproducts.com or call us at 
Corporate Headquarters (714)424-5520. 

Product Registration 

Be sure to register your BounceBack software with CMS Products, Inc. By registering your 
product, CMS Products, Inc., can offer you technical support. 

Contact Information 

CMS Products, Inc., can be contacted via the internet, e-mail, by fax, or by telephone. 

http://www.cmsproducts.com/
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Technical Support 

! You can visit our website at www.cmsproducts.com/support to view the online 
manual, additional troubleshooting pointers, and FAQ notes. 

! You can e-mail us at support@cmsproducts.com. 

! You can call Technical Support for technical assistance at (714)424-5520. 

Customer Service 

! You can contact Customer Service for Return Material Authorization (RMA) required for 
Warranty Issues and repair status at (714)424-5520 or e-mail at 
cs@cmsproducts.com 

Product Information 

For more information about our products, e-mail us at info@cmsproducts.com.  

Sales Information 

To purchase product, e-mail us at sales@cmsproducts.com or call (714)424-5520. 

mailto:sales@cmsproducts.com
http://www.cmsproduct.com/support
mailto:support@cmsproducts.com
mailto:cs@cmsproducts.com
mailto:info@cmsproducts.com
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Chapter 1: Introduction 

The BounceBack software has been designed to quickly and easily back up your valuable 
data and recover that data on an as-needed basis. You can even recover from a complete 
hard drive failure with the Professional version. You can use your external FireWire or 
USB drive to regularly back up your data or as an additional external storage device. You 
can use a single external hard drive to back up several computers, simply by installing 
the software on each computer.  

The default backup for BounceBack installation is a full backup of the entire hard drive. 
BounceBack Professional provides an identical copy of your entire source hard drive; 
everything (the operating system, applications, and data), is backed up.  

System Requirements 

Your system must meet the minimum requirements below: 

Mac OS X System Requirements 

! Macintosh computer (PowerPC G3/G4/G5 processor or Intel Core Duo/Solo) with built-in 
FireWire or USB 

! 128MB of RAM (256MB or more recommended) 

! Mac OS 10.3.9 or later  

! Supported FireWire, USB or secondary internal hard disk drive, partitioned and 
formatted under Mac OS X as Mac OS Extended format 

Mac OS X Special Requirements 

! External FireWire drives used on a PowerBook G3 may require the Apple PowerBook 
Firmware Update 2.7 or later.  

! The built-in FireWire ports on the original Blue and White PowerMac G3 may not work 
reliably (added PCI FireWire ports allow backups but the Mac cannot be booted from the 
FireWire drive).  

! The original PowerBook G3 with FireWire ports may not be able to start up from the 
FireWire drive (it is possible to swap the drive from the FireWire case into the 
PowerBook for disaster recovery). 

! Bootable backups require you to install BounceBack Professional on the system you will 
be backing up. Bootable backups ensure disaster recovery. 

! Only the user that installed BounceBack may use it. An Uninstall should be run before 
reinstalling for a different user. 
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Partitioning and Formatting the External Drives  

Formatting 

Using Apple’s Disk Utility program (found in the Applications folder inside Utilities), the 
external backup drive may be formatted on Mac OS X. (Choose Mac OS Extended 
format). GUID partitioning is required for boot-ability on Intel Macs.

 

 

 

When erasing the External drive with Apple Disk Utility, be sure to select the drive and 
not the volume. (Selecting the drive will repartition drive).  

Do not use DOS format for backups; the backups will be much slower and less reliable 
(especially for repeated backups).  

Partitioning 

If you are backing up multiple computers, and want each backup to be bootable, see 
“Backing up Multiple Computers” for detailed instructions on installing BounceBack 
Software and partitioning the external drive. 
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Features 

Congratulations on choosing the most powerful and effective backup software available 
on the market today! BounceBack has the following key features: 

!!  Initial Backup. The BounceBack installation default Backup Set is to backup the 
entire system drive, which is created as you install BounceBack. 

!!  Backup Sets.  The Settings feature allows you to create and modify Backup Sets.  
Each Backup Set allows you to specify a unique set of backup characteristics such a 
data selection, scheduling, and power down. 

!!  Data Selection.  Data for backup is selectable by drive, folder, file or file type. 

!!  Scheduling.  Backups may be automated by scheduling them.  Schedules can be 
specified by time and date, for one-time events, or on a daily or monthly basis. 

!!  Power Down.  Your computer can be set to power down on completion of backup. 

!!  Backup.  Once you have created one or more Backup Sets, the Backup feature allows 
you to select and run a Backup Set at any time. 

!!  QuickRestore.  This feature restores backed up files, reports file status and allows 
files to be purged from the backup. Files can be restored to their origin location or 
redirected to another location.  

!!  Native File Format.  Backups are in ‘native file format.’  This means that backed up 
data is always available, there is no special software needed to view files or data, 
and files can be restored in seconds by drag and drop or by using QuickRestore. 

!!  Options.  This feature allows you to specify global backup and device options. 

!!  Bootable Backup.  Typically, computers boot from an internal hard disk.  However, if 
the hard disk is damaged (for example, by a software virus or by being physical 
damaged), you can replace the damaged drive with the bootable backup device drive 
and boot the computer, (assuming you created a bootable disk in advance of the 
problem).  This feature is only available in BounceBack Professional with FireWire 
and USB external drives. (USB drives only supported on Intel Processors.) 

!!  Internal Backup.  BounceBack supports the use of internal hard drives as backup 
devices. 

!!  Data Management.  Supports backup drive data management, when files are no 
longer needed on the backup hard drive they can be reviewed and purged from the 
backup drive. 

!!  Auto Launch.  Any time you connect an external designated backup device to your 
computer; this feature scans your system disk for new or modified files and 
automatically backs them up to the backup device, FireWire or USB. 

!!  Security. Supports external FireWire hard drives. 

 

 

http://www.webopedia.com/TERM/B/virus.html
http://www.webopedia.com/TERM/B/hard_disk.html
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Chapter 2: Connecting External Drives 
 

Important Information 

It is best to connect power to the FireWire or USB drive, turn it on, and connect it to the 
Mac computer before installing any of the BounceBack software.  

Do not use PC formatted drives on the Mac unless you are only reading files. DOS drives 
are unreliable on the Mac when writing data. For best performance, drives should be 
formatted with Mac OS Extended format before being used for backup. 

 

Connecting a FireWire External Drive  

1. Connect the power supply to the drive, plug it into an outlet, and turn it on (if the 
drive has an on/off switch). 

NOTE: The CMS Portable 2.5 inch FireWire ABSplus drive is powered by the 
FireWire connection and does not have a power cord.  

2. Connect the interface cable to an appropriate FireWire port on your computer. The 
FireWire port is usually identified by “1394,” or the FireWire logo. 

 

If you cannot locate a FireWire connection, refer to the documentation for your 
computer. 

NOTE: For the best performance, connect the external drive to a built-in 
FireWire port on the computer.  

3. Connect the other end of the interface cable to the External Drive. Look closely at 
the cable ends for correct orientation when connecting. 

4. Congratulations, you’re ready to install the BounceBack software and run your 
first backup. Please read the FireWire guidelines below for important information. 

FireWire Guidelines 

! You can connect or disconnect your FireWire drive while the computer is on.  

NOTE: Before you disconnect the FireWire drive, select the drive icon and 
drag it to the Trash icon. (or choose Eject from the File menu to 
unmount the drive.)  

 You can ensure maximum performance by connecting the backup drive 
directly to your computer instead of other FireWire devices.  

  10 
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! To prevent data loss, do not plug in or disconnect additional FireWire devices while any 
FireWire device is in use.  

! For best performance, unused FireWire ports should be left empty. There are no 
terminators for FireWire connections. 

! Before connecting a Desktop drive, always turn on the drive’s power switch.  

Disconnecting the Backup Drive 

Backup Do’s and Don’ts  

! Do not disconnect your backup drive while it is backing up your files—data loss and 
corruption will result! 

! You can connect or disconnect your backup drive while the computer is on. 

To disconnect your External Hard Drive, select its icon on the Mac OS Desktop and drag it 
to the Trash icon (or choose Eject from the File menu to unmount the drive). After the 
FireWire or USB backup drive’s icon disappears, you can turn it off and/or disconnect it.
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Chapter 3: Installing BounceBack Software and Running 

Your First Backup 

Important Information 

! It is best to connect power to the drive, turn it on, and connect it to the Mac before 
installing the software. 

! It is highly recommended that you temporarily disable your virus protection software (if 
you have it); this will increase the speed of the initial full backup. See your virus 
protection software documentation and follow the instructions for temporarily disabling 
the program. 

 

Installing the BounceBack Software from CD-ROM 

To install the BounceBack software from your CD-ROM drive: 

1. Start your computer and wait for the Mac OS to finish loading. 

2. Insert the BounceBack CD into the CD-ROM drive.  

NOTE: If the CD-ROM drive has a spindle, make sure that the CD is pushed all 
the way down. 

3. Double click the BounceBack CD icon to open the BounceBack CD window.  

4. Double click the BounceBack Installer icon.  

 



Installing the Software and Running Your First Backup 

5. Click on the Install button to start the install process. You may also view the manual, 
uninstall existing software or check for upgrades from this screen. 

6. You are required to authenticate your access to the system by entering your user 
name and password. 

7. Read license and click Accept.  

8. After installing, a restart will be required so the BounceBack driver may be loaded. All 
applications should have been closed before starting any installation, any that are 
open will be closed for you. 

9. Once your system reboots, the BounceBack software has been installed. To continue, 
see Running Your First Backup. 

NOTE:  BounceBack software is installed in the Applications folder. Do not 
move or install the software to any other folder. 

Running Your First Backup 

Once the software installation is complete and your system has rebooted, the 
BounceBack software will begin to configure your first backup.  

 
1. After the operating system reboot, you will be requested to register your BounceBack 

software through a link to a registration web site. 
 
2. After registration, the software has to be activated by entering an activation code. 

The code is supplied with the BounceBack software, usually on the flap of the 
BounceBack CD cover, and consists of 4 groups of 5 characters.  

 
3. During the setup process, you will be prompted to determine the target location of  

your back up data.  
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4. Click Yes to use a second internal hard drive or external drive as the backup device. 

Click No to direct the backup to your primary hard drive. 
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5. external drive that meets 

the backup criteria and use it.  However, if both an external and internal are found, 
If you select YES, the software will look for an internal or 

the software will request a further clarification from you as to which one to use, see 
below: 

 

 

Select the name of the hard drive you wi  to use as the backup unit. If you have 
not connected the backup drive, connect t now and once it has been identified by 

 

 
 
6. Once you have selected the target location, the BounceBack software will scan your 

computer to determine the size of the backup and estimate the total amount of time 

 
 

sh
 i

the operating system, and select ‘Rescan Device List’ this will update the Device
List display to include the newly connected drive. 

to perform the backup. The backup size, time estimation, source and backup 
locations are all displayed. 
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If you choose to change the “default” backup created, you can select View Settings     
which will launch the BounceBack Control Center program enabling you to customize 
your backup. Otherwise, you may choose between starting the backup now or later. 

 

 

 

When the backup is complete the Backup Totals screen will display. 
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NOTE:  The Total Files and Folder count may differ from the number of files 
you see in the backup due to the hidden files built into the Mac OS. For 
example, each folder contains a file named “.DS_Store” which you 
cannot see. Also, the backup on the hard drive may show files and 
folders that will not show up if you boot from the Backup drive. These 
files and folders should not be deleted or disturbed if the bootability of 
the BounceBack Professional backup is to be maintained. 

(Don't forget to re-enable your virus protection software if you disabled it. See the virus 
protection software documentation for instructions on how to enable it.) 

Checking the log after backups 

A description of the backup is added to the BBLog.txt file, which is accessed by launching 
the TechRepair application in the BounceBack directory, after every backup. Entries are 
added to the log for files that are skipped due to permission problems or not backed up 
for other reasons (like a file in use).  

Unmounting an External Drive 

After you’ve successfully backed up your files, select your External drive and drag it to 
the Trash icon (or choose Eject from the File menu to unmount the drive.) After the 
drive’s icon disappears, you can turn it off and/or disconnect it. The BounceBack software 
will prompt you to connect your drive after the reminder period. 

 

NOTE: By default, the BounceBack application will automatically launch and 
initiate a backup whenever you connect a backup device. You can 
change this and other settings from the BounceBack Control Center 
application.  
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Starting Your Next Backup 

 
 

The BounceBack Control Center application is located inside the BounceBack folder 
within the Applications folder. For your convenience you can place this in the Dock or 
create an alias for it on your Desktop. Double click it to start a backup or change 
settings. Or you can use the new convenient BounceBack menu that is installed onto 
the right side of the main menu bar. If you prefer not to have this menu on the main 
menu bar, you can disable this feature from the BounceBack Control Center application. 

 

BounceBack will use the settings as defined in BounceBack Control Center, on each 
backup.  

! Any background tasks that interfere with file copying, including anti-virus software 
and file undelete software, need to be disabled for the backup drive. 

! If the external drive contains old backups, use Apple’s Disk Utility to reformat the 
drive as Mac Extended format before running the initial backup.   

! If FileVault is enabled, BBBackup will backup your home directory as encrypted. Any 
secondary users that are not logged in during the backup but have FileVault enabled, 
will have their home directories backed up as encrypted and cannot be accessed 
unless the user is logged in.  

 

Removing BounceBack Software 

To remove the BounceBack Software from your computer, you’ll need to launch the 
BounceBack installer either from your CD or launch the electronically downloaded 
installer. 

1. Double click the BounceBack Installer icon.  

2. Click the Uninstall button.  
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Chapter 4: Launching and Functions 

What’s in this Section? 

This section describes how to launch BounceBack and provides an overview of 
BounceBack functions. 

 

Section Topics 

4-1: Launching BounceBack Control Center   

4-2:  BounceBack Functions  

  Backup 

  Restore 

Security 

  Settings 

  Options 

  Help 

  Registration 

  Information  

4-3: Launching Backups 

4-4: Password Security 
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4-1: Launching  BounceBack Control Center    

 

BounceBack Control Center is easily accessed. To open BounceBack Control Center: 

 

a. Select Applications from the Go menu. 

b. Open the BounceBack folder. 

c. Double click on BounceBack Control Center. 
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4-2: BounceBack Functions   

BounceBack includes five basic functions: 

 
1. Backup 
2. Restore 
3. Security 
4. Settings 
5. Options 

 

These functions correspond to the five tabs from left to right on the top of the 
BounceBack Control Center as shown below. 

 

 

 

 - Launches the Help manual for BounceBack. 

 - Launches the Registration screen for BounceBack. 

 - Launches an information screen about the BounceBack program. 
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If you click the Yes button for this option, you are taken through a wizard to create a 
backup set. You can select predefined backup sets: Data Backup of all available files on 
the system or c:-drive. My Documents which limits the backup to a smaller amount of 
data files but usually includes all of your data files, or Let Me Choose which will allow 
you to choose the drives, folders, files or file extensions you want to backup and select a 
location for them to go.  

 

The only options available beyond the above is scheduling and naming the backup set. 

Backup 

Once you have defined one or more Backup Sets and set the options for those sets, you 
are ready to manually run backups or to have scheduled backups run automatically.   

Restore 

The Restore function, also known as QuickRestore, enables you to quickly replace lost 
data with data you have previously backed up. 

Security 

The Security function enables you to lock your external drive with a password. You will 
need the BounceBack software to unlock the drive. 

Settings 

Before running backups, you must define at least one Backup Set; usually this is done 
during the installation. The Settings function can add advanced features to any Backup 
Set.  A Backup Set is a set of characteristics that you define to create a backup for a 
specific purpose.  The characteristics that you can define include the: 

 

!!  

!!  

!!  

!!  

!!  

Scope of the Backup Set (what files or folders will be backed up) 

Destination of the Backup Set (where will the files or folders be backed up) 

Schedule of the backup (how often will the backup occur or will the backup be 
launched manually) 

Options that apply to each Backup Set 

Name of the Backup Set.   

 

In order to run backups—either manually or by scheduling backups to run automatically—
you must create at least one default Backup Set.  Create additional Backup Sets as 
needed for specific purposes. 
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Options 

Before running backups, you may also find it useful to define options for your Backup 
Set(s) using the Option function.  These are Global functions that include options for 
allowing you to:  

 

!!  

!!  

!!  

View the progress of backups 

Schedule reminders for performing manual backups 

Specify whether backups automatically launch whenever the backup device is 
connected 
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4-3: Launching Backups  

 

Scheduled Backup Sets will run automatically assuming the designated backup device is 
connected to your computer. 

 

Backups designed for a button push or connection via USB, FireWire will also run 
automatically. 

 

Manual Backups can be run at any time; all you have to do is select BounceBack Control 
Center using: 

 

a. Select Applications from the Go menu. 

b. Open the BounceBack folder. 

c. Double click on BounceBack Control Center. 
 

Backup Operation 

 

1. Click the Backup tab on the BounceBack Control Center.  
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2. Click the Yes button to continue. 

 

 

 

3. The Backup Set Selection screen above shows all backup sets. Select the Backup Set 
or Sets you want to launch by clicking the check box next to its name. To launch the 
back up, click the Backup button. 

 

 

 

4. The BounceBack software will launch into the backup or backups by first scanning 
the source drive to size the backup and then compare the data against that of the 
backup device. All files that have been modified are selected for backup. If the 
backup device or hard drive is not available then a message is displayed requesting 
you connect it before proceeding. 
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5. The Backup on completion of the scan starts the actual transfer of data. You can 
have a detailed display as shown or a single progress bar. In this example, the 
detailed display is shown. 
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6. On completion of the backup, the following screen is displayed. 

 

 

 

7. In the event of any major problems with the backup, the status field identifies errors 
occurring during the backup.  If this occurs, review the backup error log found in 
BounceBack TechRepair to identify if this is a serious issue or if some files were 
inaccessible to the backup because they were in use. 
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4-4: Password Security  

 

BounceBack Control Center Security enables the hard drive’s password protection 
features.  When the hard drive password protection is locked, it is impossible to access 
the hard drive without the password to unlock it.  If the hard drive password is lost, it will 
be impossible to recover the drive data.  CMS Products customer service has no “back 
door” for retrieving passwords. 

BounceBack Control Center Security allows you to configure your external backup drive 
to be password protected and it can be integrated into the backup process. Think of it as 
just another option to a data set. You can also password protect your external unit 
independent of the backup operation. 

NOTE: Not all external hard drives support password protection. 

Launching BounceBack Control Center Security 

 

To launch BounceBack Control Center Security Wizard 

 

! Click the BounceBack Launcher icon  and then click BounceBack Control Center and 
then the Security Tab. 

 

Or 

 

! Click Applications from the Go menu, open the BounceBack folder, double click on 
BounceBack Control Center and then click the Security Tab. 



SSeeccuurriittyy  
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The Security Device List screen displays all password enable devices found.  Click the 
drive you wish to protect and then click Next to move on to the Password Selection 
Screen. 

If you have not connected your device, connect it now and click Refresh, this will refresh 
the device list.  Back will return you to the BounceBack Control Center. 
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Password Selection 

 

 

Enter Password – Shows a * character for each typed key, up to 32 characters can be 
used. 

Verify Password – Shows a * character for each key typed, up to 32 characters can be 
used.  Enter and Verify password must match otherwise an error occurs when you try to 
lock a device. 

I Forgot – If present and active, clicking this button allows you to answer a question that, 
if answered correctly, will retrieve your forgotten password. (See Options below.) 

Lock Device – This button executes a Lock which actually locks the external hard drive 
with the password you typed into Enter and Verify Password.  If a device is locked then the 
button is renamed to Unlock Device.  This button executes an Unlock which actually 
unlocks or removes the password from a locked device. 

Done – Returns you back to the BounceBack Control Center 

Back – Takes you back one screen, in this case to the Security Device List 

Options – Takes you to the Password Options Screen.  
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Password Options 

 

 

1. Always Prompt for Password Before Backing Up – If checked, you will have 
to enter the password in order for the backup program to continue. If you leave 
this unchecked, the software will mange your password and unlock the device 
before the backup takes place. 

2. Ask Me a Security Question if I Forget My Password – If checked, when you 
lock a device with a password, the software will prompts you with the Password 
Reminder Screen.  The Password Reminder Screen asks you to select a question 
and enter an answer.  If you forget your password, you can click on the I Forgot 
button.  The Password Reminder Screen appears asking you to enter the answer to 
the selected question.  If you answer the question correctly, it will provide you 
with the password. 

 

NOTE:  For added security; once this option is selected you will have to respond correctly to 
the reminder in order to change it. 
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Select Password Reminder 

If Ask Me a Security Question if I Forget My Password is checked and the Lock 
Device button is clicked, the Select Password Reminder Screen appears. 

 

 

 

It allows you to select a reminder question and enter an answer.  When you click Accept, 
you have set up a second chance to retrieve a forgotten password. 

 

Password Reminder 

The Password Reminder Screen appears when you click an active I Forgot button.   

 
It is asking you to enter the answer to the selected question.  Once you have entered 
your answer, click Lookup.  If the answer is correct, the password is displayed. 
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Adding the Password-Protection 

Follow these steps to add password-protection: 

1. In the BounceBack Control Center program, click the Security tab. 

2. If needed, select the device to password protect from the device list. Any locked 
drives are identified as such. 

3. Enter your password in the Enter and Verify Password text boxes and click the Lock 
Device button. 

4. The device is now password protected. 

 

 

 

Removing the Password-Protection 

Follow these steps to remove the password-protection: 

1. In the BounceBack Control Center program, click the Security tab. 

2. If needed, select the device to remove the password from the device list. Any locked 
drives are identified as such. 
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3. Enter your password in the Enter and Verify Password text boxes and click the 
Unlock Device button. 

4. The device is now unlocked. 
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Chapter 5: Settings and Options 

What’s in this Section? 

In this section you will learn how to create Backup Sets.  

 

Section Topics 

5-1:  Settings Function Overview 

5-2: Creating a New Backup Set 

5-3: Scheduling A Backup Set 

5-4: Backup Options 
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5-1: Settings Function Overview   

 

This feature is accessed from the BounceBack Control Center by moving the cursor onto 
and clicking the Settings tab.  It lets you create or modify backup sets, using the 
Settings Wizard. This wizard will take you through a series of screens and you may add, 
change or remove characteristics of the backup set as you progress.  

 

The Settings Function supports the following settings for a backup set: 

   Create a Backup Set 

   Modify a Backup Set 

   Select backup sources from drives, folders, files 

   Select backup locations by drive, and existing or new folder 

   Data Verify 

   Unattended operation 

   Computer Shut Down (power off) on completion of backup 

   Excluding drive, folders or files from a backup set 

   Scheduling Backups 

    

A Backup Set is a set of characteristics that you define to create a backup for a specific 
purpose.  Before running backups, you must have defined at least one Backup Set; this is 
usually performed during the installation of the software.  Create additional Backup Sets 
as needed for specific purposes. 
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Click the Settings tab to begin the process of creating or modifying a Backup Set.  

 

 

Follow the screens to create a Backup Set. 
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To create new Backup Set, click Add.  Creating a new Backup Set is described below. 

 

To delete an existing Backup Set, click the desired name in the Backup Set column and 
then click Remove, and then click Accept. 

 

To schedule automatic backup for an existing Backup Set, click the desired name in the 
Backup Set column and then click Schedule.  

 

To modify an existing Backup Set, click the desired name in the Backup Set column and 
then click Next.   

 

When you create or modify a backup set on the completion of the wizard, you will return 
to this screen, by clicking Accept you are confirming the changes or additions you made. 

 

To exit the Settings function without creating or modifying a Backup Set, click Cancel. 
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5-2: Creating a New Backup Set 

When creating a new Backup Set, you will first be asked to define the scope of the 
Backup Set.  That is, you will be asked to specify what type of characteristic you want for 
the backup set, including what data to backup and the locations it will come from and go 
to. 

 

After clicking Settings and Add on the Backup Set List screen, the following screen 
displays:   

 

 

Caution:  At any step in creating a Backup Set, if you click Cancel or Start Over 
you will lose all the information that you have entered to that point. 

 

Backup Set Options 

In the Backup Set Options sections, select any of the Backup Set Options you wish to 
apply to the backup set. By default, no selections are necessary. 

!!  Verify Data — If this option is checked, each backed up file will be verified against 
its source.  During the actual backing up of the data set, a verify progress bar will 
display to show progress of the verify function.  Verifying takes a slightly shorter 
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time than a backup because no writing to the hard drives is required; therefore, a 
backup with verify will take slightly less than twice as long as a backup alone. 
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!!  

!!  

Unattended Backup — If this option is selected, BounceBack will run without any 
user interaction. The program will log all results.  

Shutdown System on Completion — If this option is selected, BounceBack will 
shut down your computer after it performs a backup. The software will display a 30 
second countdown warning you before it shuts down the system (requires 
Unattended Backup). 

 

Once you have made your selections, click the Next button and the Backup Item 
Selection screen will display. 

 

Click the Add button and the Select Files and Folders to Backup screen will display to 
select the drives, folders or files for the backup set. 
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If you highlight a drive by clicking its icon, it will be the source of the backup set. If you 
double click on a drive you will open the display to next level of folders.  

To continue, click the Choose button when you have made your drive, folder or file 
selections for backup. 

 

 

 

The next step is to pick a location for the selected data in the backup set to be sent. 
Select a drive by highlighting it or open it by double clicking on it. 
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Once a drive is opened, you can select an existing folder or create a new folder to store 
the backups in. To create a new folder, click the cursor in the New Folder: text box and 
enter the name you want. 

Click the Choose button once you have selected your backup storage location. 

 

 

 

To continue, click the Next button 
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Backup Set Exclusions allow the user to exclude specific items from a backup set. If you 
select No, Backup Everything and then click Next, you will move on to the scheduling 
screen and skip the exclusion list selection screens. 

If you want to exclude something select Yes, I want to select folders or files to exclude 
from this backup set and then click Next. 
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Click the Add button to start the selection process. 
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By double clicking on folders you reach your desired folder to exclude.  

Click Choose once you have made your selection. 

 

 

A summary of the exclusions you have made are listed, you can Add or Remove until 
you have your final selection of exclusions. These exclusions apply to the Backup Set 
being created only. 

 

To continue, click the Next button 
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5-3: Scheduling a Backup Set 

 

 

If you intend to use a time schedule for backing up your computer, select the Launch 
backups at Scheduled Intervals and then click the Next button. 

 

If you intend to launch backups by any other means, select I will Manually Launch My 
Backups and then click the Next button, this will skip the scheduling screens. 

 

Note: If a scheduled backup is missed because the computer was off, 
BounceBack displays a message when the computer is powered on giving 
you the options of running the missed backup immediately or to wait until 
a more convenient time.   
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Not scheduled is the default.   
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Click Once to schedule a one-time automatic backup. 

 

 

 

Use the drop-down list to specify the time and the date of the backup. 
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Click Daily to schedule a daily backup. 

 

 

 

Use the drop-down list to specify the time of the backup.  Use the check boxes to specify 
the days of the week to perform backups.   

  48 
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Click Monthly to schedule monthly backups. 

 

 

 

Use the drop-down lists to specify the time of day and day of the month for the backup.   

 

After specifying the frequency of backups, click Next to continue, which displays the 
Backup Set Summary screen. 
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Optionally, you can change the name in the Backup Set Name field. The BounceBack 
software will generate default names for you. The Scheduled For field displays the 
scheduled backup time(s).  If manual backup was selected, this field will display a value 
of Not Scheduled.  The Options field displays any selected options for the Backup Set. 

 

To modify the schedule, click the Back button.  Otherwise, click Done to indicate no 
more changes or modifications are needed. 
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Clicking Accept completes the wizard and now stores the backup set. 

 

This completes the Settings wizard operation.   
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5-4: Options Function Overview  

As displayed when you move your mouse over the Options tab, the Options function 
allows you to specify options that apply to all of your backup sets. 

 

 

 

These options are not configured through the Settings function because they apply to all 
Backup Sets.  Settings allow you to configure options that are specific to individual 
Backup Sets. 
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Backup Options 

Clicking the Options tab displays the Backup Options screen. 

 

 

 

Backup options include: 

 

Remind Me to Backup Every X Days ! To set a reminder for manual backups, use the 
arrows to set the number of days before a reminder occurs. BounceBack tracks the 
time between backups and reminds you when you need to perform a backup.  

 

Scheduler Assumes the Backup Device is Always Available ! Use this option if 
you plan to keep your backup drive always connected to your PC. The scheduler 
automatically backs up your data as you defined in each of your Backup Sets.  If you 
disconnect the backup drive, BounceBack will remind you that you have missed 
scheduled backups.  If this option is NOT checked, scheduled backups will only occur 
when the device is connected to your computer. 

 

Scheduled Backups Launch Only on Connection of a Backup Device ! Use this 
option to launch scheduled backups ONLY when the backup device is connected. This 
mode of scheduling is designed for the mobile user who does not normally have the 
backup device connected to the computer. 

 

To exit the Options Function, click Cancel. 

To accept changes made to Backup Options, click Accept. 
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Chapter 6: Recovering Your Data 

Recovering data that you have accidentally lost, archived, or want to transfer to another 
computer is easy with the BounceBack software and backup drive. 

  

BounceBack Restore  

BounceBack Restore provides a convenient method of accessing or restoring files from the 
backup drive. This is not the only method you can use to access your data however. To run 
BounceBack Restore: 

1. Select Applications from the Go menu. 

2. Open the BounceBack folder. 

3. Double click on BounceBack Restore. 

After completing a backup, the BounceBack Restore display should look something like this: 

 

Each of the items in BounceBack Restore is explained below: 

Restore Window  

The Restore window allows the user to navigate the drives and folders contained in the 
backup. 

Double-clicking a file will open it with the default program for that file type. Double-
clicking a folder will open that folder and re-display its contents. When the Restore 
window is displayed in detailed mode (the default mode), the filename, modification date, 
file size, status, and file kind is displayed for each file. The status value represents a 
comparison of each file with that of the original file on the source drive. The status can be 
any one of the following: 
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! Unchanged – this version of the file is the same as the original source file  

! Older – this version of the file is older than the original source file 

! Newer – this version of the file is newer than the original source file 

! Deleted – the original source file has been deleted 

  

Tool Bar 

The tool bar in BounceBack Restore contains the following items: 

Info Button 

The Info button displays information about the currently selected item(s) in the Folder 
and Data panes. It can display info for drives, files, or folders. 

Purge Button 

The Purge button allows you to remove from the backup drive all folders and files that 
have been deleted from the original source drive. See “Purging Deleted Files” below for 
more information.  

Restore Button 

The Restore button restores the currently selected files and folders to the path displayed 
in the Restore Path pull-down. See “Restoring Data” for more information. 

Restore Path Pull-Down 

The Restore Path pull-down indicates where files and folders you restore with the 
Restore button should be copied to. By default, the selected data is restored back to its 
original location on the source drive. You can use the Browse option in the pull-down 
to choose a re-directed location such as the desktop to restore to. The program will 
automatically remember the last ten restore paths you select the next time you restore 
data. See “Restoring Data” for more information. 
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Restoring Data 

BounceBack Restore can restore files and folders backed up to the backup drive quickly 
and easily. The steps to restore data are as follows:  

1.  Start BounceBack Restore. 

2.  Navigate the folder tree in the Restore window to locate the parent folder 
containing the files and folders to restore. 

3.  Select the files and/or folders to restore. 

NOTE:  If you wish to restore your data to a folder other than the original 
location, use the Restore Path pull-down and Browse for the new 
location to restore your data. 

4. Click the Restore button. Your data will be restored to the location indicated in the 
Restore Path pull-down. The default restore location is the folder where the file was 
originally backed up from on your computer. 

5. At the Restore Files window you have the following Restore Options. Select the 
one you want and click OK. 

 

! Overwrite Existing Files Without Asking – this option will overwrite any 
corresponding files that already exist with the same name in the Restore Path with 
the files you select for restore. 

! Prompt before Overwriting – this option will prompt you and ask if you want to 
overwrite any files in the Restore Path with the same name. 

! Do Not Overwrite Existing Files – this option will only write files in the Restore 
Path which do not have a corresponding file with the same name. 

! Create Full Path Structure – this option will re-create the path structure of the file 
to restore, as it exists on the backup drive before copying it to the restore location. 
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NOTE:  The Create Full Path Structure option is ONLY available when re-
directing the restore to a path other than the original source location. 

 

6. The Restore Statistics displays the size and number of files and folders you have 
chosen to restore, along with the disk space available at the Restore Location. 
Click Continue to begin the restore process. 

 

 

Purging Deleted Files 

BounceBack Restore provides a method of removing files which have been deleted from 
t on the backup drive.  

To purge deleted files from the backup drive, follow these steps: 

1. 

2. er in the Restore Window you would like to perform the 
purge operation on. Any folder or subfolder in the backup structure can be selected. 

iles from the entire backup drive, click the icon representing 
the backup drive letter. 

3. Click the Purge button. 

4. After a warning message, the BounceBack Restore display should be similar to:  

he source drive but that still exist 

 Start BounceBack Restore. 

 Click (highlight) the fold

To purge all the deleted f

 

he Purge Files window, you have the following Purge Options: 5. At t

ut prompting. 
! Delete Purged Files Without Asking – this option purges all deleted files in 

the folder selected in the Folder Pane from the backup drive witho

! Prompt before Purging Each File – this option also purges all deleted files in
 folder selected in the Folder Pane, but will prompt you each. 

 
the  

N r deleted files, OTE: These options will not only search the selected folder fo
but will also search any sub-folders inside of the selected folder. 

Select Delete Purged Files Without Asking and click OK. 

6. The Purge Results window will be displayed. Click OK. 
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Recovering from a Disk Crash 

Before you attempt the procedures in this section, make sure that you have ruled out 
other causes for your computer’s problems. You may want to check the following first: 

! Recently installed software (especially if the software added items into your 
System Folder). 

! Testing your hard disk with Apple’s Disk First Aid. Disk First Aid is integrated into 
the Disk Utility application. The Disk Utility application is located in the 
“Applications” folder inside “Utilities.” 

Once you have ruled out the above issues, you can use one of the following procedures 
to start your computer from your Mac OS CD-ROM and recover from a system failure. 

 

Mac OS X Recovery Instructions (BounceBack Professional Only ) 
 

1. If you have a FireWire drive, it may be possible to select it as the startup drive while 
starting up. To try that, restart the Mac while holding the option key down. You will be 
presented with a list of drives that have systems. Scanning for drives may take a 
while, be patient. Your FireWire drive will show up probably with a FireWire symbol 
instead of a name. Click on this drive to select it for startup and then hit the arrow 
key to continue. If you are able to do this you can use Apple’s Disk Utility program 
to format and partition your internal disk, if necessary.  

2. If you are not able to startup from the external FireWire drive and you have a desktop 
Mac, disconnecting the internal hard drive and starting up your computer with the 
External FireWire drive connected should force your Mac to use the FireWire 
backup drive as the startup disk if you don't have another disk with a valid Mac OS. 
Set the FireWire drive as the startup disk, shut down and reconnect your internal hard 
drive, then restart. You can then partition and format your internal hard drive with 
Apple’s Drive Setup program, if necessary. 

3. Locate the already installed and configured  BounceBack Restore program on the 
backup drive and use BounceBack Restore to restore all the files you need to your 
internal drive. (The drive you restore to should have the same name as the one you 
originally backed up. BounceBack Restore can then restore back to the original 
locations.)  See “BounceBack Restore” and “Restoring Data” for details on the 
BounceBack Restore application. 
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Chapter 7: Backing Up Multiple Computers 

You can use the BounceBack software to backup multiple computers to a single external 
FireWire drive.  

! To backup multiple computers, where only one of the backups will be bootable, see 
“Setting Up Separate Folders for Multiple Computer Backups.”  

! To backup multiple computers, where all of the backups are bootable, see “Setting 
Up Separate Partitions for Multiple Computer Backups.” 

Setting Up Separate Folders for Multiple Computer Backups  

To back up multiple computers, set up a separate backup folder for each computer that 
you want to back up.  

Use the Mac OS to create additional backup folders on the backup drive. 

1. Double click the backup drive icon to open the drive window. 

2. Open the File menu. 

3. Select New Folder. 

4. Type in a name for the folder. 

5. Use the BounceBack Settings window on each computer to set the folder you just 
made as the destination of the computer’s Backup Item.  

6. Run a full backup on each computer. 

NOTE:  Only the backup of the computer with the Destination set to the root of 
the backup drive will be bootable, if BounceBack Professional was 
used.   

Setting Up Separate Partitions for Multiple Computer Backups  

You can use the external FireWire drive to create bootable backups for multiple 
computers, using BounceBack Professional. To do so, you must do the following: 

1. Partition the backup drive so that each computer can be backed up to a separate 
partition. This should be done using Apple’s Disk Utility program (found in the 
Applications folder inside Utilities). Follow the instructions provided by the utility. 

2. Install the BounceBack Professional software on each computer. 

3. Connect the Backup drive to the computer. 

4. Configure the BounceBack Backup Item or Set with the appropriate Source and 
Destination. 

5. Run a full backup. 

6. Repeat steps 3-5 for each computer.
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Chapter 8: Troubleshooting and Technical Support 

This chapter includes troubleshooting tips and contact information for technical support. 

Problems and Solutions 

Problem Solution 

How do I restore the default 
BounceBack backup settings? 

Uninstalling the BounceBack software 
and then reinstalling will restore the 
default backup settings. 

Can I use multiple drives to back up 
my Mac. 

Yes. However, make sure that each 
backup drive that you mount has a 
different name. This gives you the 
ability to back up different items to 
different drives. 

If you don’t give each drive a different 
name, the BounceBack software will 
only work with the one that mounts 
first. 

 

I’m having trouble mounting and/or 
unmounting the external drive with 
Mac OS X. 

If a drive doesn't mount on Mac OS X 
after being attached: 

1. The drive may mount if you log out 
and log back in to the Mac. 

2. If that doesn't work, shut down the 
Mac completely and then start it 
up. (Before starting up, make sure 
that the power disconnects from 
the backup drive by turning off its 
power switch or momentarily 
disconnecting it from the 
Macintosh if it doesn’t have a 
power switch.) 

3. Have all the system updates from 
Apple been installed? Operate on 
the most current OS system.  

If the drive is mounted but won't 
unmount because Mac OS X claims it 
is in use, log out of Mac OS X and log 
back in to quit whatever process is 
using it. You should then be able to 
unmount the backup drive. 
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I have a DOS formatted backup drive 
that I now want to use for my Mac. 
What do I do?  

You should not use a DOS formatted 
drive for backup on a Mac, the file 
system would eventually be corrupted. 
To remedy this, you will need to put a 
Mac format on the disk.  

Format and partition disks using the 
“Mac OS Extended” format by using 
the Disk Utility application. The Disk 
Utility application is located in the 
Applications folder inside Utilities. 

Additional Information: 

Do not use PC formatted (DOS) drives 
on a Mac unless you are only reading 
the files. Writing to a DOS drive is not 
reliable unless you are writing to a 
blank drive. If you need to reliably 
write to a DOS drive, always erase the 
entire disk (not just the files) before 
writing to the disk again. To avoid this 
problem and see better performance, 
drives that are used for backup should 
be formatted with the Mac Extended 
format. 

 

My Backup drive works but the backup 
is not bootable. 

Did you use BounceBack Professional? 

The back drive must be partitioned 
and formatted for Mac OS X using 
Apple’s Disk Utility. Select the hard 
drive, not the backup volume when 
performing an Erase. 

Reformat the backup drive if an old 
backup was on the drive when the 
new BounceBack software was 
installed. Then run the software and 
select Disaster Recovery.   

My backup is bootable, but some 
things don’t work correctly. 

Make sure you are using the most 
current version of the BounceBack 
software. Revisions can be 
downloaded from 
www.cmsproducts.com. 

Reformat the backup drive if an old 
backup was on the drive when the 
new BounceBack software was 
installed and run a full backup.  

How do I upgrade my Mac OS? You can update your Mac OS X system 
software by using the Software Update 
control panel/system preference panel 
supplied by Apple. 

For this to work, you will need an 

http://www.cmsproducts.com/
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Internet connection. 

For OS X, CMS recommends upgrading 
to the latest version of the operating 
system. 

After running System Update and 
restarting your Mac, you may need to 
run System Update again. Some 
updates may not be available until an 
earlier update and restart is done first. 
Therefore, it may be necessary to 
update, restart, and repeat until no 
more updates are available. 

 

Are there any limitations in file and 
folder names? 

Special symbols such as / or \ and " 
and $ should be avoided in file and 
folder names. Mac OS X will have 
difficulty with them. 

 

What’s in BBDrives.txt? There is additional information for 
technical support purposes. Please be 
prepared to send the file to CMS in 
addition to the BBLog file if tech 
support requests it. 

 

The backup drive is locking up or the 
drive is becoming corrupt. 

If you are having problems with the 
drive locking up or the format on the 
drive is becoming corrupt, it may be 
due to your drive being shipped in a 
DOS rather than a Mac format. You 
can check this by selecting the backup 
drive and selecting either Get Info or 
Show Info from the File menu in the 
Finder. In the information window, you 
will see a field called format. This 
should say Mac OS Extended. If your 
drive is formatted in a DOS format see 
the above problem, "I have a DOS 
formatted drive that I now want to use 
for my Mac. What do I do?” 

The problem with DOS formatted disks 
is a Mac OS problem and occurs under 
both Mac OS 9 and Mac OS X on any 
drive using this format. DOS format 
works if you use it as read-only and 
never write to the disk. If you write to 
the disk you risk corrupting the drive. 

If you are still having problems with 
the backup drive locking up, you may 
have a conflict with an anti-virus 
program or another background disk 
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utility program. The problem may be 
avoided by disabling the utility 
program during backups, if possible, 
just for the backup drive. For example, 
it is possible to disable Norton 
FileSaver for just the backup drive 
while leaving it available for other 
drives. Go into the FileSaver program 
and uncheck “Update disk directory 
info” and “Track Deleted File/Folders” 
for the backup drive. 

 
 

I replaced my internal drive with the 
backup drive and now none of my 
aliases work. 

Try renaming the backup drive to have 
the same name as the original source 
drive. 

If you have a lot of aliases on your 
drive, the aliases may break on 
backups because they will point to the 
original source drive, which is no 
longer present.   

If you rename your backup drive to 
the original source drive’s name, the 
aliases may work and point to files on 
the backup drive. When restoring from 
the backup drive to the source drive or 
replacing the source drive with a new 
drive it is important for the restored 
drive to have the same name as the 
original source drive, after the restore 
is completed. 

 

I can’t use my backup drive to start up 
from a different Macintosh. 

If you can’t start up from your backup 
drive after moving it to a different 
Macintosh, it may be necessary to 
update or upgrade the MAC OS on the 
backup drive before it will be possible 
to start up from it. This may also work 
if the backup was incomplete. 
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Technical Support Information 

For Customer Service and Technical Support please contact a CMS representative or your 
local CMS reseller.  

Before calling technical support, you should determine the exact version and build date of 
your BounceBack software. This information is contained in the Information tab in the 
BounceBack Settings application window. Alternatively, using the Get Info or Show info 
command on an BounceBack program file can provide the same information. 

For Technical Support:  

! You can visit our website at http://www.cmsproducts.com/support to view the 
online manual, additional troubleshooting pointers, and technical notes. 

! You can e-mail us at support@cmsproducts.com. 

! You can call Customer Support at (714)424-5520 or fax Customer Support at 
(714)435-9483. 

Please be ready to provide the technician with the make and model of your notebook, the 
operating system you are using. If possible, have your notebook available when making 
the call. 

When e-mailing or faxing, include the make and model of your notebook or PC, the 
operating system you are using, as well as any information you feel is pertinent. Please 
include a phone number where you can be reached, and your fax number or e-mail 
address so that we can contact you. 

NOTE:  No products will be accepted as returns unless shipped with a return 
authorization. Call CMS Customer Service for more information.  

 

mailto:support@cmsproducts.com
http://www.cmsproducts.com/support
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